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3Bienvenidos a prime:vocal 

prime:vocal es una herramienta impulsada por IA para 
la limpieza y mejora profesional de voces, disponible 
como aplicación independiente y como plug-in ARA 
(versión BETA) para una integración perfecta con DAW  
compatibles. Tanto si te enfrentas a condiciones 
de grabación poco ideales como si simplemente  
buscas con esmero un sonido con calidad de estudio, 
prime:vocal garantiza que cada pista vocal suene pulida 
e inmaculada.  

La aplicación proporciona herramientas esenciales, 
como la reducción de ruido y de ambiente, que actúan 
conjuntamente para eliminar elementos no deseados 
como el ruido de fondo, la reverberación o filtraciones 
de otros sonidos por el micrófono. prime:vocal también 
mejora eficazmente las grabaciones de voz cantada o 
hablada reduciendo de forma inteligente las sibilancias 
y consonantes oclusivas demasiado acentuadas. 
 
Para un perfeccionamiento avanzado del audio, se  
incluye una función adicional de dinámica que ajusta los 
niveles promedio y de pico para lograr una nivelación 
profesional, mientras que un control de balance 
permite perfeccionar la señal para obtener una calidad 
de tono óptima. 



4Instalación 

MacOS
 
Para iniciar el proceso de instalación, abre la imagen 
de disco sonible_primevocal_osx_x.x.x.dmg. Esto  
montará la imagen y abrirá una ventana del buscador 
mostrando el contenido del paquete de instalación.

Para instalar prime:vocal en tu sistema, ejecuta el archivo 
de instalación primevocal.pkg.

El instalador te guiará por los pasos necesarios para  
instalar prime:vocal en tu computadora. La versión  
independiente se instalará en la carpeta Aplicaciones, 
mientras que la versión plug-in (ARA) se colocará en las 
ubicaciones predeterminadas para plug-ins de audio. 

Audio Unit (ARA)
/Library/Audio/Plug-Ins/Components/

VST3 (ARA)
/Library/Audio/Plug-Ins/VST3/ 

Requisitos del sistema 

Necesitarás permisos de administrador  
para instalar correctamente prime:vocal. 

Windows
 
Para iniciar el proceso de instalación, extrae el  
archivo descargado sonible_primevocal_win_x.x.x.zip  
en tu disco duro y ejecuta el instalador. 

El instalador te guiará por los pasos necesarios para  
instalar prime:vocal en tu computadora. La versión  
independiente se instalará en la carpeta Archivos de  
programa, mientras que la versión plug-in (ARA) se  
ubicará en las ubicaciones predeterminadas para plug-ins 
de audio. 

VST3 (ARA)
C:\Program Files\Common Files\VST3\ 

CPU
Intel Core i (8va generación)
Apple M1+

RAM
8GB

Sistemas operativos 
Windows 10+ (64 bit)
MacOS 11+

OpenGL Version 3.2+



5Autorización   

Desbloqueo 

Si has adquirido una licencia para usar prime:vocal en 
línea, recibirás tu clave de licencia por correo electrónico. 

Desbloqueo Machine-based
Si has adquirido una licencia para usar prime:vocal en 
línea, recibirás tu clave de licencia por correo electrónico. 

Asegúrate de que tu computadora esté conectada a  
Internet antes de iniciar el proceso de registro. 
Introduce tu clave de licencia y haz clic en “registrar”. El 
software se comunicará ahora con nuestro servidor para 
comprobar si la licencia es válida. Si es así, ¡disfrútalo! :) 

iLok
Si has transferido tu licencia a un dispositivo USB iLok, 
simplemente conecta el dispositivo a tu computadora. 
Si has transferido la licencia a iLok Cloud, asegúrate de  
iniciar una sesión en la nube antes de abrir el producto. 

Si no recibes el correo electrónico en unos minutos,  
comprueba primero tu carpeta de correo no deseado  
antes de ponerte en contacto con nuestro servicio de  
asistencia (support@sonible.com).

Versión de prueba

Para ejecutar prime:vocal en modo demo, simplemente 
haz clic en “probar” y podrás utilizar prime:vocal  
durante un par de días sin ninguna limitación. Consulta nuestro  
sitio web para obtener más información sobre el período 
de prueba actual. 
Cuando expire el periodo de prueba, deberás adquirir una 
licencia completa para poder seguir utilizando el producto. 

Requisitos de conexión a Internet 
Los productos de sonible sólo necesitan una conexión a 
Internet durante el periodo de prueba y para la activación 
inicial de la licencia. Durante el periodo de prueba, el  
producto debe conectarse a Internet cada vez que se  
utilice. Una vez que la licencia de tu producto se ha activado 
correctamente, ya no es necesaria una conexión a Internet. 

Sistema de licencia 

Puedes elegir entre dos sistemas de licencias: por  
digital o iLok. 

Creando una cuenta de usuario en www.sonible.com y 
registrando tus productos (si aún no están visibles en 
tu Pantalla principal) podrás gestionar tus activaciones. 

Machine-based
Cada clave de licencia te permite instalar prime:vocal en 
dos computadoras con identificadores de sistema únicos. 
Estos identificadores de sistema se computan durante la 
activación de la licencia. 

La misma licencia puede ser utilizada por varios  
usuarios, pero cada uno de ellos tiene que desbloquear  
individualmente la versión completa de prime:vocal en 
su cuenta. 

En caso de que cambie el ID del sistema (por ejemplo, 
si se sustituye el disco duro), puede anular/activar el  
producto junto al ID del sistema correspondiente en la 
Pantalla principal de tu cuenta de usuario de sonible. 

iLok
Si quieres transferir una activación a tu cuenta iLok (el 
adaptador USB iLok o iLok Cloud son compatibles), 
sólo tienes que asegurarse de que el producto esté  
registrado en tu cuenta de usuario de sonible. Haz clic en 
el botón “transferir a iLok” situado junto al producto en tu  
Pantalla principal (www.sonible.com/my-account) y sigue las  
instrucciones. 

Nota: Los adaptadores iLok de primera generación no son 
compatibles actualmente. 

prime:vocal



6Interfaz del usuario 

Barra de pestañas 
Cambia entre distintos 
archivos de audio de la 
sesión actual (aplicación 
independiente) o distintas 
pistas (plug-in ARA). 

Zoom
Acerca/aleja el zoom en los 
ejes de tiempo (horizontal) y 
amplitud (vertical). También 
puedes utilizar la rueda 
del ratón para hacer zoom 
horizontal. 

Controles de reproducción  
y código de tiempo     
Controla la reproducción de audio (salta para iniciar, 
reproducir/pausar, detener, activar la reproducción en 
bucle) y monitorea la posición actual del cabezal de  
reproducción. 

Medición y  
ganancia de 

 

la salida
 
 

Ajusta una ganancia de  
salida y controla el nivel 
RMS y de pico de la señal 
de salida. 

Comparación A/B y presets 
Utiliza la opción A/B para comparar dos ajustes de 
parámetros diferentes y almacenar o cargar presets. 

Barra de vista 
general de la pista 
La Barra de vista general 
de la pista muestra el  
archivo de audio completo 
(aplicación independiente) 
o la pista (plug-in ARA) 
e indica el progreso del  
proceso de análisis. Haz 
clic en cualquier lugar de la 
Barra de vista general de la  
pista para mostrar la sección  
correspondiente. 

Bypass y diferencial 
Pasa por alto todo el 
procesamiento o escucha la 
diferencia entre la señal de 
entrada y la señal de salida 
procesada. 

Sección de ajuste preciso 
Ajusta los módulos de procesamiento aplicando una  
ponderación de frecuencia para la reducción de ruido y 
reverberación. Los módulos Vocal Clean-up, Spectral  
Balance y Dynamics también vienen con parámetros  
adicionales para ajustar. 

Parámetros de control principales 
Controla los principales módulos de procesamiento: 
Noise Reduction, Room Reduction, Vocal Clean-up 
(sibilantes, consonantes oclusivas), Dynamics (nivelación 
y compresión) y Equilibrio de espectro.

Panel Automation 
Monitorea y controla la 
automatización de los 
parámetros.  

Visualización de 
la forma de onda 
Monitorea la forma de onda 
del audio. Amplía la imagen 
para ver señales adicionales 
que muestran el ruido y la 
reverberación estimados, 
así como las secciones de 
sibilancias y consonantes 
oclusivas detectadas. 
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1.Carga de archivos de audio
Hay dos formas de cargar archivos de audio:  
•	 Carga a través del menú File (Archivo): Puedes 

cargar uno o varios archivos de audio a través de la 
opción de menú “File > Import Audio File” (Archivo 
> Importar archivo de audio). (Para más información 
sobre el menú File, consulta la página 20)  

•	 Carga mediante arrastrar y soltar: puedes  
arrastrar y soltar uno o varios archivos de audio  
directamente en la ventana de la aplicación de  
prime:vocal. Después de cargar un archivo, se crea 
una nueva pestaña con el nombre del archivo y se inicia  
automáticamente el análisis del fichero.

2. Proceso de análisis
El progreso del proceso de análisis se muestra en la  
Barra de vista general de la pista. Una vez analizada una  
determinada sección de la pista, puedes empezar a  
trabajar en ella. Las partes que aún no se han analizado no 
pueden reproducirse hasta que finalice el análisis. 

INFO: Proceso de análisis fuera de línea
prime:vocal utiliza redes neuronales altamente 
especializadas para detectar y corregir problemas en 
el archivo de audio. Estas redes requieren recursos 
computacionales relativamente altos, lo que significa 
que el análisis completo de un archivo de audio 
(dependiendo del hardware del sistema de destino) tarda 
aproximadamente la duración del archivo analizado (por 
ejemplo, analizar un archivo de 1 minuto de duración 

Sesiones
En cuanto se importen uno o más archivos de audio en 
prime:vocal, se crea una sesión temporal.

Si deseas seguir trabajando en una sesión más  
adelante, puedes guardarla como archivo de sesión 
prime:vocal (*.pvocproj) en  “File > Save Session”  
(Archivo > Guardar sesión). El archivo de sesión  
guarda los ajustes de parámetros de todos los archivos de  
audio abiertos en ese momento. Además, todos 
los datos de análisis se guardarán en una carpeta  
independiente llamada “analysis” junto al archivo de  
sesión. Si no tienes previsto realizar más pasos de 
edición después de exportar los archivos, sólo tienes 
que cerrar prime:vocal y se eliminará la sesión temporal.

Nota: El tamaño de las carpetas de análisis  
prime:vocal almacenadas con una sesión puede llegar a ser  
bastante grande debido a la cantidad de datos de  
análisis. Se necesitan aproximadamente 90 MB de datos de  
análisis para 1 minuto de material de audio. 

Primeros pasos (aplicación independiente)

3. Empezar a afinar
Una vez finalizado el análisis, puedes ajustar la  
configuración de prime:vocal según sea necesario. 
Cualquier cambio que hagas se reflejará al instante  
visualmente y en la reproducción de audio. 

4. Exportar archivo(s) de audio
Cuando estés satisfecho con los resultados, podrás  
exportar fácilmente el archivo procesado. Para más  
información sobre el proceso de exportación, consulta la 
página 19. 



8Primeros pasos (plug-in ARA | versión BETA) 

1. Cargando prime:vocal
Carga prime:vocal como plug-in ARA. El proceso varía en 
función de la DAW: consulte al fabricante de su DAW para 
obtener información detallada sobre cómo se implementa 
la integración ARA en su DAW específica. 

2. Proceso de análisis
Una vez cargado el plug-in, prime:vocal analizará todos 
los clips de audio de la pista. El proceso de análisis puede  
llevar algún tiempo, dependiendo de la longitud de los 
clips. Si se añaden nuevos clips de audio a una pista, 
se inicia automáticamente el proceso de análisis de los  
nuevos clips. 

Las secciones analizadas de un clip se resaltan en verde 
en la Barra de vista general de la pista y el progreso  
general del análisis de todos los clips se muestra en una 
barra de progreso. Las partes no analizadas del clip no 
podrán reproducirse hasta que finalice el proceso. 

3. Empezar a afinar
Una vez finalizado el análisis, puedes ajustar la  
configuración de prime:vocal según sea necesario.  
Cualquier cambio que hagas se reflejará al instante  
visualmente y en la reproducción de audio. 

Además de su versión independiente, prime:vocal  
también está disponible como plug-in ARA  
(Acceso aleatorio a audio) en versión BETA. Este avanzado  
formato de plug-in permite una mayor integración con 
las DAW compatibles*, ya que agiliza el flujo de trabajo 
y elimina la necesidad de exportar y reimportar audio.   
 
Nota: prime:vocal sólo puede cargarse como plug-in 
ARA y no como plug-in estándar.

¿Qué es ARA (Acceso 
 

aleatorio a audio)? 
La tecnología ARA mejora la comunicación entre un  
plug-in y la DAW, permitiendo al plug-in acceder a archivos 
de audio o clips enteros a la vez, en lugar de trabajar con 
datos de audio en tiempo real. 

ya se haya procesado completamente con prime:vocal,  
importar el archivo optimizado y, a continuación,  
eliminar prime:vocal del proyecto. 

* La versión ARA de prime:vocal (BETA) es compatible con 
los DAW que admiten el protocolo ARA, como:

•	 Steinberg Cubase/Nuendo
•	 Presonus Studio One
•	 Cockos REAPER
•	 Apple Logic Pro**

** En Apple Silicon, Logic Pro debe ejecutarse en modo 
Rosetta para ser compatible con ARA.

Consulte el manual de su DAW para asegurarse de que 
ARA está permitido y correctamente configurado. 

4. Exportar audio
Una vez que estés satisfecho con los resultados, puedes 
simplemente exportar tu pista o proyecto. El proceso 
de renderizado (exportación) es idéntico al proceso de  
renderizado cuando se utilizan plug-ins estándar. 

Proceso de análisis fuera 
 

de línea y datos de análisis 
prime:vocal utiliza redes neuronales para detectar y  
corregir problemas en el archivo de audio. Estas  
redes requieren recursos computacionales relativamente  
altos, lo que significa que el análisis completo de un 
archivo de audio (dependiendo del hardware del  
sistema de destino) tarda aproximadamente la  
duración del archivo analizado (por ejemplo, analizar un  
archivo de 1 minuto de duración llevará aproximadamente 
1 minuto). Ten en cuenta también que, aunque un clip 
esté recortado al principio o al final, prime:vocal analizará 
todo el archivo de audio subyacente. 

Los datos de análisis generados por prime:vocal se 
almacenan en la carpeta de medios del archivo de 
proyecto de tu DAW (si tu DAW lo admite) o en una  
carpeta personalizable (consulta Preferencias  
generales en la página 22) para garantizar que todo el  
procesamiento permanezca intacto al volver a abrir la 
sesión.  

Los datos de análisis pueden ser bastante grandes: 
aproximadamente 90 MB por minuto de audio. Por 
este motivo, puede resultar útil exportar una pista que 
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La Pantalla principal muestra una sección de la  
forma de onda del archivo de audio cargado (aplicación  
independiente) o de la pista (plug-in ARA).

Señales mostradas  
Inicialmente, la Pantalla principal sólo muestra la señal de 
entrada. En cuanto finalice el análisis de una sección, se 
mostrarán los componentes adicionales de la señal (ver 
debajo), así como la señal de salida que cambia en tiempo 
real con los ajustes de los parámetros. Al alejar el zoom, si 

Pantalla principal 

el intervalo visualizado supera los 120 segundos, sólo se 
mostrará la señal de entrada. 

La sección de la señal que se va a mostrar se puede  
seleccionar a través de la Ventana de vista en la  
Barra de vista general de la pista (ver página 17). El  
nivel de zoom de la señal visualizada puede ajustarse tanto  
horizontalmente (eje temporal) como verticalmente (eje de 
amplitud). 

Verde: Componente de ruido Rosa: Componente de reverberación Naranja: Secciones con sibilantes  
o consonantes oclusivas



10Noise Reduction

El módulo Noise Reduction (Reducción del ruido)  
permite eliminar de la señal todos los componentes o  
interferencias que no sean de la voz cantada o hablada. 
Una ponderación de frecuencia independiente (ver página 
12) permite ajustar con precisión el proceso de limpieza. 

Eliminación del ruido de fondo  
Los componentes típicos del ruido son el ruido estático de 
fondo, como el ruido de ventiladores, aire acondicionado o 
zumbidos eléctricos, o ruidos molestos de corta duración, 
como portazos, toques involuntarios del micrófono, ruido 
de tráfico o pisadas. 

Eliminación de la diafonía 
Además de eliminar los ruidos típicos, prime:vocal  

también permite eliminar los componentes de señal no 
deseados de otros instrumentos, lo que se conoce como 
interferencia en el micrófono o diafonía. Esta función  
resulta especialmente útil cuando se graban varias  
fuentes (por ejemplo, voz y guitarra) en las que resulta difícil  
separarlas acústicamente de forma adecuada.  

Nota: prime:vocal está capacitado para detectar y eliminar 
la diafonía. Aunque el programa también puede utilizarse 
para extraer pistas vocales de una mezcla de audio, no 
se ha optimizado específicamente para esta tarea, por lo 
que los resultados pueden variar significativamente. 
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El parámetro Room Reduction permite reducir las  
influencias no deseadas de la sala (reflexiones y 
reverberación). Una ponderación de frecuencias 
independiente (ver página 12) permite ajustar con precisión 
el efecto.

prime:vocal se ha entrenado específicamente para  
detectar y eliminar el sonido ambiente de la forma 
más limpia posible en típicos entornos de grabación 
subóptimos (por ejemplo, salas de estar, salas de  
ensayo, locales de shows en vivo). Aunque la  
herramienta también puede utilizarse para reducir  
reverberaciones muy largas (por ejemplo, 
reverberaciones artificiales o reverberaciones en una 
iglesia), es posible que un procesamiento más fuerte 

Room Reduction

en tales situaciones introduzca artefactos no deseados. 
ejemplo, reverberaciones artificiales o reverberaciones en 
una iglesia), es posible que un procesamiento más fuerte 
en tales situaciones introduzca artefactos no deseados.
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La ponderación de frecuencias permite ajustar por  
separado la intensidad de los módulos Noise Reduction y 
Room Reduction en diferentes rangos de frecuencia. Por 
ejemplo, si una señal sólo contiene un componente de  
ruido de baja frecuencia (por ejemplo, el zumbido de un 
transformador), puedes reducir el impacto de la reducción de 
ruido en rangos de frecuencia más altos. Aunque prime:vocal 
funciona de forma extremadamente limpia, esta opción  
adicional de ajuste preciso ofrece la ventaja de evitar posibles  
artefactos no deseados derivados de un procesamiento 
excesivo en áreas específicas. 

Las líneas horizontales permiten aumentar (>100) o 
disminuir (<100) el impacto de la banda en el rango de 
frecuencias correspondiente. Si el parámetro de reducción 
de ruido global ya está en su valor máximo (100), un 
impacto de banda >100 no tendrá ningún efecto, ya que 
la reducción máxima para esa banda ya está aplicada.  

Las frecuencias de transición de las tres bandas de  
frecuencia pueden ajustarse mediante las líneas verticales.  

El símbolo de auriculares permite escuchar la gama de 
frecuencias seleccionada de forma aislada. 

Ponderación de frecuencias 
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De-Essing  
El módulo De-Essing detecta tanto el tipo como la natu-
raleza de las sibilantes, lo que facilita el manejo de los soni-
dos “s”, “z” o “sh” molestos. 

•	 none: El módulo De-Essing está desactivado.  
•	 soft: Reducción ligera de las sibilantes molestas. 
•	 medium: Reducción moderada de los sibilantes 

molestas. 
•	 strong: Reducción fuerte de las sibilantes. En 

algunos casos, esto puede dar lugar a coloraciones 
tonales no deseadas.

De-Plosive  
El módulo De-Plosive detecta tanto el tipo como la na-
turaleza de las consonantes oclusivas, lo que facilita el 
manejo de sonidos molestos “p”, “t” o “k”. 

•	 none: El módulo De-Plosive está desactivado.  
•	 soft: Reducción ligera de consonantes oclusivas 

molestas.
•	 medium: Reducción moderada de consonantes 

oclusivas molestas. 
•	 strong: Reducción fuerte de las consonantes oclusivas. 

En algunos casos, esto puede dar lugar a coloraciones 
tonales no deseadas.

El módulo Vocal Clean-up permite solucionar los 
problemas típicos de las grabaciones de voz cantada 
y hablada, como las sibilantes o consonantes oclusivas 
demasiado acentuadas.  

prime:vocal detecta automáticamente estos distintos 
componentes de la señal y te permite ajustar la intensidad 
de la reducción para cada tipo de señal por separado. 

Vocal Clean-up
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El módulo Dynamics combina dos técnicas clave de 
procesamiento de audio (nivelación y compresión) para 
conseguir un rango dinámico bien equilibrado en la señal. 
Esto ayuda a garantizar que la grabación mantenga un 
nivel constante y corrige las fluctuaciones no deseadas. 

Level Riding 
Level Riding ajusta el nivel promedio de la señal de audio, 
aumentándolo o atenuándolo automáticamente para 
mantener el volumen estable durante toda la grabación. 
Esta técnica ayuda a gestionar el volumen general y a 
garantizar que la voz cantada o hablada mantenga una 
presencia consistente. 

•	 Soft: Proporciona ajustes suaves del nivel, ofreciendo 
cambios mínimos. Es adecuado para grabaciones con 
ligeras variaciones de volumen en las que se necesita 
un realce sutil. 

•	 Medium: Aplica ajustes moderados al nivel, 
abordando variaciones más notables en el volumen. 
Ideal para grabaciones con fluctuaciones moderadas 
que necesitan un poco más de control.  

•	 Strong: Aplica ajustes significativos al nivel, 
controlando eficazmente las variaciones de volumen 
más grandes. Esto es útil para grabaciones con 
cambios de nivel pronunciados o para conseguir una 
sonoridad muy consistente.

Compression 
La compresión reduce el rango dinámico de la señal. Esto 
ayuda a que el audio sea más uniforme y controlado, 
evitando que los picos sean demasiado altos y las 
secciones más suaves demasiado bajas. Los cambios 
de nivel inducidos por la compresión se compensan 
automáticamente. 
 
•	 Soft: Proporciona una compresión ligera, ofreciendo 

una reducción mínima del rango dinámico. Este 
ajuste es adecuado para grabaciones en las que sólo 
se necesita un ligero control sobre los picos y las 
depresiones.  

•	 Medium: Aplica una compresión moderada, 
gestionando eficazmente el rango dinámico para 
una salida más equilibrada. Utilice este ajuste para 
grabaciones con dinámicas moderadas que necesiten 
un poco más de control.  

•	 Strong: Aplica una compresión fuerte para reducir 
significativamente el rango dinámico. Ideal para 
grabaciones con grandes variaciones dinámicas o 
para conseguir un sonido muy controlado y uniforme.

Dynamics
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El módulo Spectral Balance tiene como objetivo equilibrar 
la señal de voz, eliminando cualquier problema de espectro 
o coloración tonal para garantizar que la señal suene limpia 
y presente. 

En los ajustes avanzados, puedes seleccionar un perfil 
adecuado (Vocal Low, Vocal High, Speech Low, Speech 
High) y el parámetro Colour te permite establecer  
adicionalmente un carácter tímbrico deseado para 
adaptar el procesamiento a tus preferencias.

Profile
El ajuste Profile determina cómo se ajusta el espectro en 
función del tipo de grabación. “Vocal Low” y “Vocal High” 
están optimizados para grabaciones de voz cantada, 
mientras que “Speech Low” y “Speech High” están 
pensados para señales de voz hablada. Los términos Low 
y High se refieren al tono de la grabación, siendo Low 
adecuado para voces más graves y High para las más 
agudas. 

Colour
El parámetro Colour te permite adaptar el carácter tonal 
de tu grabación. Ajustando este parámetro, puedes 
influir en la forma del sonido general de la grabación de 
voz hablada o cantada. El parámetro ofrece diferentes 
opciones (Warm, Neutral y Bright), cada una de las cuales 
afecta al balance de frecuencias y a la calidad tonal de la 
siguiente manera: 

•	 Warm: La configuración Warm está diseñada 
para proporcionar un sonido rico y con cuerpo, 
centrándose en realzar las frecuencias medias. Este 
ajuste añade una agradable calidez a la pista de voz 
cantada o hablada, haciéndola sonar más íntima y 
suave. Las frecuencias altas se suavizan ligeramente 
para garantizar una experiencia auditiva cómoda, 
evitando cualquier aspereza. 

•	 Neutral: La configuración Neutral mantiene un sonido 
equilibrado en todo el espectro de frecuencias. Sirve 
como ajuste predeterminado para todos los perfiles, 
con el objetivo de preservar el carácter original de la 
grabación sin añadir coloración tonal adicional. Este estilo 
es ideal para conseguir un sonido natural, sin colorear, 
adecuado para una amplia gama de aplicaciones. 

•	 Bright: La configuración  Bright introduce un elemento 
de espacio y brillo en la grabación al acentuar las 
frecuencias altas y medias-altas. Este ajuste está 
diseñado para hacer que el sonido de voz cantada 
o hablada sea más brillante y presente, añadiendo 
claridad y definición. Es especialmente útil para 
resaltar detalles y hacer que la grabación destaque en 
una mezcla. 

Spectral Balance
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Con la automatización, puedes controlar la intensidad 
de procesamiento de módulos individuales a lo largo del 
tiempo. Ten en cuenta que sólo se pueden automatizar 
los parámetros principales de cada módulo. Mientras la 
automatización está activa para un módulo, el parámetro 
no se puede ajustar manualmente con la perilla de control.  

La ventana de automatización puede mostrarse u 
ocultarse haciendo clic en “Automation”. La ventana de 
automatización muestra una curva de automatización para 
cada módulo con automatización activada. 

NOTA: Cuando se utiliza la versión ARA de prime:vocal, no 
se puede aplicar la automatización estándar de DAW. A 
diferencia de los plug-ins tradicionales, los plug-ins ARA 
no utilizan parámetros clásicos para la automatización. 
En su lugar, cualquier ajuste de la configuración de 
prime:vocal debe realizarse directamente en la interfaz 
del plug-in. 

Interacciones de la curva 
 

de automatización 
•	 Activa la automatización de un módulo para visualizar 

la curva de automatización correspondiente.  
•	 Un doble clic en la curva de automatización crea un 

nuevo punto de automatización.  
•	 Al hacer doble clic en un punto de automatización 

existente, se borra dicho punto.  
•	 Mueve los puntos de automatización y la línea entre 

dos puntos con el mouse.  
•	 Al hacer clic en “Reset All” se borrarán todos los 

puntos de automatización de la curva seleccionada 
en ese momento. 
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Controles de transporte 
•	 reproducir desde el principio: saltar al principio del 

archivo de audio  
•	 reproducir/pausar: iniciar y pausar la reproducción 

de audio  
•	 detener: detener la reproducción de audio   
•	 modo bucle: permite reproducir una región 

seleccionada en bucle. 

Barra de vista general de la pista   
La Barra de vista general de la pista muestra la forma 
de onda completa del archivo de audio cargado (app) o 
de la pista (plug-in). La barra de progreso gris muestra 
el progreso general del análisis; la forma de onda de 
audio verde indica que ya se ha analizado una sección 
determinada. 

Región del Bucle 
Para reproducir una sección específica de la señal en 
bucle, se puede definir una Región de bucle. Cuando 
el modo bucle está activo, la reproducción comienza 
siempre al principio del bucle. Al final del bucle, el cabezal 
de reproducción salta automáticamente al principio de la 
región del bucle sin ninguna pausa.	   
 
Para crear una región de bucle, seleccione la sección de 
señal correspondiente en la Pantalla principal o en la Línea 
de tiempo marcándola de izquierda a derecha. 

Barra de pestañas (Plug-in ARA) 
Cada pestaña representa una pista con una instancia de 
prime:vocal. Seleccionando una pestaña puedes cambiar 
entre prime:vocal en diferentes pistas. 

Ventana de vista 
Con la Ventana de vista, puedes seleccionar la parte del 
archivo de audio que se mostrará en la Pantalla principal.  

•	 Mueve la ventana a la izquierda o a la derecha para 
saltar a otra sección del archivo de audio.  

•	 Arrastra el borde izquierdo o derecho para ampliar o 
reducir la sección del archivo de audio que se muestra 
en la pantalla principal.  

Una vez creada una región de bucle, el modo bucle se 
activa automáticamente. Puedes activar y desactivar 
el modo bucle haciendo clic en el icono de bucle de la 
sección Controles de transporte.  

•	 El tamaño de la región del bucle puede ajustarse 
moviendo los dos límites del bucle.  

•	 Toda la región del bucle puede desplazarse a izquierda 
o derecha arrastrando la región seleccionada. 

•	 En el caso del plug-in ARA, la región de bucle se 
sincroniza con los ajustes de bucle de la DAW (si es 
compatible). 

A/B & Presets
Utiliza la opción A/B para comparar dos ajustes de 
parámetros diferentes y guardar o cargar presets. 

Línea de tiempo  
La línea de tiempo muestra la posición de reproducción 
actual en horas, minutos y segundos:  
•	 Utiliza la rueda del mouse para acercar o alejar la 

imagen.  
•	 Haz clic y arrastra el cursor hacia la izquierda o la 

derecha en la línea de tiempo para crear una región 
de bucle. 

 

Barra de pestañas
  

(aplicación independiente) 
Cada pestaña representa una pista con una instancia de 
prime:vocal. Seleccionando una pestaña puedes cambiar 
entre prime:vocal en diferentes pistas. 
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La sección de la señal que se va a mostrar se puede 
seleccionar a través de la Ventana de vista en la Barra 
de vista general de la pista de la pista (ver página 12). 
El nivel de zoom de la señal visualizada puede ajustarse 
tanto horizontalmente (eje temporal) como verticalmente 
(eje de amplitud). 

Eje de zoom de la amplitud 
•	 Utiliza el control deslizante de zoom vertical. 

Ten en cuenta que el zoom sobre el eje de amplitud es 
puramente visual y no tiene ningún efecto sobre el nivel 
real de la señal de salida.  

Eje de zoom del tiempo 
Hay tres formas de ampliar el eje de tiempo: 

•	 Utiliza la rueda del mouse mientras el cursor se 
encuentra en la ventana de Pantalla principal, Línea 
de tiempo o la Barra de vista general de la pista  

•	 Mueve los bordes de la Ventana de vista a la 
izquierda o a la derecha   

•	 Utilizar el control deslizante horizontal del zoom
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Cuando estés satisfecho con el resultado del 
procesamiento, podrás exportar el archivo de audio 
editado. 

Exportar a través del menú File 
Los archivos de audio individuales pueden exportarse a 
través de la opción de menú “File > Export Audio File” 
(Archivo > Exportar archivo de audio).  

Todos los archivos de una sesión pueden exportarse 
mediante “File > Export All Audio Files” (Archivo > 
Exportar todos los archivos de audio).

La región de bucle seleccionada de un archivo puede 
exportarse mediante “File > Export Selection” (Archivo > 
Exportar selección). 

Ajustes de exportación 
Al exportar archivos de audio, se pueden configurar los 
siguientes parámetros. La mayoría de los parámetros 
están disponibles para todos los tipos de exportación; 
algunos (por ejemplo, esquemas de nombres específicos) 
sólo están disponibles al exportar varios archivos. 

Formato 
*.wav 
*.aiff 
*.ogg 
*.flac 

Sample Rate 
22.05kHz, 44.1kHz, 48kHz, 88,2kHz, 96kHz 

Normalización 
•	 off: no aplicar ninguna 

normalización 
•	 Loudness [LUFS]: 

normalizar a un nivel 
de sonoridad medio 

•	 Peak [dB]: normalizar 
a un determinado nivel 
de pico máximo 

•	 Target Level: 
Establece un nivel 
objetivo (LUFS o dB) 
para la normalización.

Nombrar 
•	 Custom: exportar con 

nombre personalizado 
•	 Original: exportar con 

el nombre original 
•	 Original + Suffix:  

exportar con el 
nombre original + el 
sufijo elegido   

•	 Custom + Number: 
nombre personalizado 
+ numeración 
secuencial (sólo para 
exportación de varios 
archivos)

Profundidad de bits (sólo formatos 
sin pérdida de calidad) 
16, 24, 32 

Tasa de transferencia de bits (sólo 
formatos con pérdida de calidad) 
128, 192, 256, 320 
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Menú Archivo 

Import Audio File 
Importa un nuevo archivo de audio a la sesión actual. 

New Session 
Crea una nueva sesión vacía en una nueva ventana de 
la aplicación. 

Open Session
Abre una sesión prime:vocal existente. 

Save Session
Guarda la sesión actual como un archivo PVXX.

Save Session as 
Guarda la sesión actual con un nuevo nombre. 

Remove Audio File 
Elimina de la sesión el archivo de audio asociado a la 
pestaña activa en ese momento. 

Export 
Exporta el archivo de audio editado asociado a la 
pestaña activa en ese momento. 

Export all 
Exporta todos los archivos de audio editados asociados 
a la sesión actual. 

Export Selection 
Exporta la región de bucle editada de la pestaña activa 
en ese momento. 

Close Session 
Cierra la sesión actual. Ten en cuenta que los cambios 
no guardados se perderán. 

Close all Sessions 
Cierra todas las sesiones actualmente abiertas  
(ventanas de aplicaciones). Ten en cuenta que los  
cambios no guardados se perderán. 

Barra de menú (aplicación independiente) 
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Un Preset guarda los ajustes aplicados al archivo actual.  

Para guardar un Preset, haz clic en “save” junto al menú 
desplegable de Presets.   

Para cargar un preset guardado, selecciona el nombre del 
preset correspondiente en el menú desplegable.

Para eliminar un preset o cambiarle el nombre, ve a la 
carpeta de presets en el explorador de archivos local.   

Puedes compartir fácilmente tus presets entre diferentes 
estaciones de trabajo. Todos los presets se guardan con 
la extensión de archivo “.spr” en las siguientes carpetas:

Carpetas de presets   
macOS: ~/Library/Audio/Presets/sonible/primevocal 

Windows: My Documents\Presets\sonible\primevocal Presets  
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Para acceder a la página de configuración, haz clic en la 
rueda dentada de la esquina superior derecha o visita la ruta 
de menú “Edit > Preferences” (aplicación independiente). 

Preferencias generales 

Use OpenGL  
OpenGL puede causar problemas de renderizado en 
determinados equipos informáticos. Utiliza esta opción 
para deshabilitar OpenGL. 

Plug-in Information  
Aquí puedes encontrar el nombre y la versión de tu 
plug-in. Inicia el recorrido de bienvenida, una resumen 
rápido de las características del plug-in, haciendo clic 
en “mostrar tutorial”.

Share anonymous user  
data with

 
sonible  

Actívalo para compartir datos de usuario totalmente anón-
imos con sonible y ayudarnos a mejorar la aplicación.

License Information  
Esto mostrará el estado y el número de tu licencia 
(cuando no se encuentre autorizado a través de iLok).

Update Notice  
Cuando esté disponible una nueva versión del plug-in, 
recibirás una notificación.

Store Analysis Data With Project    
Actívalo para almacenar los datos de análisis dentro 
de la carpeta de medios de tu proyecto DAW. Ten en 
cuenta que no todos las DAW admiten esta opción. Si 
no se admite esta opción, se utilizará la carpeta Analysis 
Data (ver abajo). 

Size of Control Elements
Define un tamaño por defecto para todos los elementos 
de control (por ejemplo, controles deslizantes). 

Analysis Data (carpeta)
Si tu DAW no soporta el almacenamiento en la carpeta 
de datos multimedia, o si has desactivado la opción 
(ver arriba), esta carpeta se utilizará para tus datos de 
análisis.

La carpeta de datos de análisis por defecto es la carpeta 
“Music” del directorio de usuario:

Mac: ~/Music/sonible/primevocal

Windows: C:\Users\<user>\Music\sonible\
primevocal
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Preferencias de audio  
(Aplicación independiente)

Output device 
Selecciona el dispositivo de reproducción de audio.

Active output channels
Selecciona los canales que se utilizarán para la  
reproducción.

Sample Rate
Define una frecuencia de muestreo de reproducción.

Buffer Size
Define un tamaño de búfer para la reproducción de audio.

Preferencias de 

 

exportación por defecto 
 

(aplicación autónoma)

La sección de exportación permite definir el formato 
de exportación por defecto. Los ajustes definidos aquí 
también se utilizarán al exportar un archivo de audio 
mediante arrastrar y soltar, por ejemplo, en una DAW. 
 
Para más detalles sobre los ajustes específicos de 
exportación, consulta la página 19.
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